


 



PPC SPO Manual 

Part X, Error Feedback, Reports and Queries 

Chapter 1, SPO Exception Report 

Overview 

 
Introduction An application has been developed in Direct Access that integrates a number 

of JUMPS Exception Processes into one area. This reduces the effort needed 
to work exceptions and provide more timely exception information to the 
SPO. As part of the Direct Access application for the JUMPS Exception 
Process, we have developed a SPO Exception Report. This allows the SPOs 
to begin viewing information on exceptions, which need their attention in a 
more timely fashion. Here’s an overview of the new process. 

 
Stage Description 

1 The DA/JUMPS production cycle runs and exception data is loaded into DA. 
Exception data from the previous update cycle is marked as “inactive” and is no 
longer viewable by SPOs. 

2 • PPC begins working exceptions through the DA Exception Punch Process 
application.  If an exception needs the attention or further action by the SPO, PPC 
has a field they will set to indicate there is a SPO responsibility. Once that field is 
set showing a SPO responsibility, the SPO will be able to view it through their DA 
application.   

• PPC (MAS) will notify SPOs, by e-mail, when error feedback information is 
available in DA. Negative reports (e. g. No SPO responsibility errors) will also be 
provided. (Note:  SPOs do not need to wait for e-mail notification to begin 
working errors. The information will be accessible by the SPO when PPC sets the 
responsibility field.  E-mail notification will not be sent until all errors are worked 
by PPC.) 

3 The SPO brings up the SPO Exception application and searches for exceptions in 
their area of responsibility that have been assigned to them by PPC. The page will 
show information about the exception and a Notes section, which details the action 
that needs to be taken by the SPO.  

4 The SPO takes corrective action as described in the Notes section of the exception 
application and sets the responsibility field to “SPO Action Complete”. 

Continued on next page 
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Overview, Continued 

 
Discussion Transactions input by SPO’s (through Direct Access) are processed by PPC to 

update the Automated Pay Master File (JUMPS).  PPC batches the 
transmitted input from SPOs, and approximately weekly, performs an update 
cycle.  A schedule of update cycles is provided by ALSPO message on an 
annual basis. 
  
Each transaction input for an update cycle must pass through a series of edit 
checks to ensure that the transaction is valid.  If the transaction fails an edit 
check, it will reject and be recorded in the JUMPS Exception Punch Process. 
  
PPC (MAS) Exception Reporting Team (ERT) members will analyze each 
rejected transaction on the JUMPS Exception Punch Process to determine the 
cause of the error and necessary corrective action.  The corrective action may 
consist of PPC (MAS): 
• Recycling the transaction, 
• Initiating action to resolve the invalid condition, or 
• Reporting the error back to the SPO for appropriate corrective action. 

The report returned to the SPO is accessible in DA (Administer Workforce > 
Administer Workforce (GBL) > Report > SPO Exceptions). 
 

 
References (a)  E-Mail ALSPO F/05; SPO Exception Report 

 
Contents This chapter contains the following topics. 
 

Topic See Page 
SPO Action X-1-3 
Procedure X-1-5 
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SPO Action 

 
Introduction The SPO is responsible for reviewing the SPO Exception Report and 

correcting invalid documents.  SPOs will only be able to view current 
production cycle exceptions.  Therefore, SPOs must take corrective action 
prior to the next update cycle. 

 
Discussion SPO’s are required to take corrective action.  Corrective action may consist 

of: 
• Correcting the original transaction, 
• Deleting the transaction, or 
• Submitting additional transactions to allow processing of the original 

transaction. 
 

Any allotments or pay entitlement starts, stops, or changes appearing on the 
JUMPS Exception Report which have not processed may lead to the member 
being overpaid or underpaid. Anytime the member’s pay will reflect an 
overpayment/underpayment resulting from a transaction not processing, 
notify the member via his/her unit. 
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Procedure 

 
Introduction Start Internet Explorer, sign into Direct Access and follow these steps to 

complete this procedure. 

 
Procedure The following outlines the Exception Report correction process. 

 
Step Action 

1 Select menu items in the following order:  
Administer Workforce > Administer Workforce (GBL) > Report > SPO Exceptions  

2 The Search Criteria Page will display.  

 
You may view error reports by: 
• The member's employee ID number (EmplID) 
• The SPO's DD-OPFAC (District and/or OPFAC number) 
• The employee ID of the person who prepared the transaction 
• Responsible Area (Note: Only Servicing Personnel Office or SPO Action Complete 

will return any results for SPO users). 

Complete at least one of the search criteria fields and click the button 

Continued on next page 
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Procedure, Continued 

  
Procedure (continued) 

Step Action 
3 

 
 
Search Results Fields 

Field Description 
EmplID The member's employee ID number 
Process Date Date of the JUMPS update/compute cycle 
Sequence 
Number 

Number of records for this member in this process cycle. 

Administrativ
e Target Unit 

The ATU/District of the SPO submitting the transaction 

Operational 
Facility Code 

The OPFAC of the unit where the SPO is located 

Preparer's 
EmplID 

The employee ID number of the person who submitted the transaction. 

Responsible 
Area 

• SPO for "Servicing Personnel Office", indicating an item that the 
SPO needs to take action on. 

• SAC for "SPO Action Complete, indicating that the SPO has 
reviewed the item and taken action. 

 

4 View the error information and take action as described in the PPC Notes section to 
correct the error. After corrective action has been completed, set the Responsible Area 
field to "SPO Action Complete" and click the button. 

Continued on next page 
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Procedure, Continued 

  
Procedure (continued) 

Step Action 
4 

cont. 

 
SPO Exception Page Fields: 

JUMPS Exception Data Section 
Field Description 

EmplID The member's employee ID number 
SSN The member's social security number 

ANAME First five letters of the member's last name 
Key Mod Key Mode. For system/PPC use only. 

Dist District Code 
OPFAC Operational Facility Code 

PAT Personnel Action Transmittal 
Prep Date Date of the transmittal 
Exc Rel Exception Release Code. For system/PPC use only. 

Comp FL Compute Flag. For system/PPC use only. 
Form 
Code 

Code describing the JUMPS transaction form type: 
L25B Officer Personnel Change transaction 
L30B Rough Order transaction 
L45B Advance Authorization transaction 
L61B Entry into the CG (Enlistment Contract) transaction (DD Fm 4/1) 
L62B Discharge to Immediately Reenlist transaction (DD Form 4/1) 
L63B Leave Reporting transaction (CG-2519) 

 

Continued on next page 
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Procedure, Continued 

  
Procedure (continued) 

Step Action 
   4 
cont. 

 
JUMPS Exception Data Section (continued) 

Field Description 
Form Code 

(cont.) 
L64B BAQ Dependency/Emergency Data transaction (CG-4170A) 
L65B Active Duty Initial Information transaction 
L66B Officer Uniform Allowance transaction 
L67B Personnel Action transaction 
L68B PCS Departing, PCS Reporting, RELAD, and Retirement 
transactions 
L6AB NJP and Court Martial transactions 
L6BB Family Separation Housing (FSH)/Allowance transaction 
L6DB Allotment Authorization transaction 
L6EB Tax Information transaction 
L6FB Statement of Intent transaction 
L6GB Payment Option Election transaction 
L6HB Military Payroll Money List (offline payments of advance pay 
to a mbr) 
L6KB Clothing and Small Stores Checkage Transaction 

Effdt Effective Date 
Efftm Effective Time 

TY Entry Type of Entry: 
• Blank  = Original 
• “C”     = Correction 
• “D”     = Deletion 

Action 
Code 

JUMPS Action Code. Refer to Part IX of this manual for a listing of 
action codes. 

Peoplesoft Information Section 
Preparer’s 
EmplID 

Employee ID number of the person submitting the transaction 

Preparer’s 
Name 

Name of the person submitting the transaction 

Description Description of the transaction type 
PPC Information Section 

PPC Notes Action required by your SPO prior to the next update cycle. 
 Explanatory remarks keyed in by the PPC (MAS), Error Reporting 
Team (ERT). 

 

Continued on next page 
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Procedure, Continued 

  
Procedure (continued) 

Step Action 
4 

cont. 
 

PPC Information Section (continued) 
J Responsible 

Area 
A drop-down menu showing the responsible party for the exception. 
• SPO for "Servicing Personnel Office", indicating an item that the SP   

to take action on. 
• SAC for "SPO Action Complete, indicating that the SPO has reviewe   

item and taken action. 
Note: There are other options on this menu. However, only "Servicing 
Personnel Office" or "SPO Action Complete" can be selected. The othe  
options are for PPC use only. 

                           on (continued  
Exception 

Cycles 
Number of cycles this error has been reported 

 

5 Utilize the buttons to return to the search page, view 
the next error report or view the previous error report. 

 

 
 



 



PPC SPO Manual 

Part X, Error Feedback, Reports and Queries 

Chapter 2, Reports and Queries 

Overview 

  
Introduction This section provides the procedures for Direct Access Reports and Queries 

  
Topics The following topics are covered in this section 
 
Overview ......................................................................................................................................... 1 
Using Process Scheduler's Web Delivery Option ........................................................................... 2 
ASQ Status Report .......................................................................................................................... 7 
Active Duty 6th or 10th Anniversary Query ................................................................................. 13 
Accomplishment Report ............................................................................................................... 17 
Begin Service Report .................................................................................................................... 21 
Competency/Qualifications Report ............................................................................................... 25 
ID Family Members/Dependents by Birth Date ........................................................................... 29 
Leave Delete Report ..................................................................................................................... 35 
PCS Orders Query......................................................................................................................... 39 
Personnel Data Information File Report ....................................................................................... 43 
Physical Characteristics Query ..................................................................................................... 47 
Accessing/Printing Unit Members PDEs ...................................................................................... 51 
Printing SWE PDEs by Department ............................................................................................. 53 
Recall Roster ................................................................................................................................. 59 
Recall Roster by ISC/HRS ............................................................................................................ 61 
Request Courses Completed by ISC or SPO ................................................................................ 63 
Reserve Orders Accounting Information Query ........................................................................... 67 
Reserve Orders Information Report .............................................................................................. 69 
Reserve Orders TONO Information Query ................................................................................... 75 
Senior Enlisted Academy Course Completion Query .................................................................. 77 
SPO Exception Report .................................................................................................................. 81 
Travel Charge Card Report ........................................................................................................... 89 
Run Training by Department Queries ........................................................................................... 91 
Unit Roster .................................................................................................................................... 97 
User Role Query ......................................................................................................................... 105 
CG Member Married to Member Query ..................................................................................... 107 
MGIB-SR RESERVE Reaffiliation Query ................................................................................. 111 
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Using Process Scheduler's Web Delivery Option 

 
Introduction Most reports use the Process Scheduler to run and deliver the report.  The 

report procedures used to discuss using the email option to deliver the report 
to your email address.   However, with the transition to MyPortalDirect, the 
email option was removed from the menu. This change was made to prevent 
personally identifiable information (PII) from being transmitted outside the 
Coast Gaud Data Network via email. All reports are now delivered via the 
reports server. 

 
Procedure Follow these steps to use Process Scheduler's Web delivery option. 

 
Step Action 

1 Access the Process Scheduler for the report you want to run and complete the run control 
page per that report's instructions. Then, click the Run button to access the Process 
Scheduler Request page. 
  

 
Note: The server name field can be left blank. It most cases, the system will select the 
appropriate server. Check the documentation for the report/process you are running. If 
the Server Name has to be set, the documentation will provide guidance.  

2 Select Web from the Process Type drop down menu. 

 

Continued on next page 
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Using Process Scheduler's Web Delivery Option, Continued 

  
Procedure (continued) 

 
Step Action 

3 Select the file format.  Not all file formats are supported by all reports, CSV and PDF are 
the most reliable. 
  
CSV = Readable by MS Excel, text editors, other spreadsheet programs and database 

applications. 
HTM = Web page 
PDF = Adobe Acrobat 

4 Click the OK button to launch the process and return to the Process Scheduler Request 
page. 

5 Click the Process Monitor link in the upper right-hand corner of the Process Scheduler 
Request page. 

 
6 The Process Monitor page will display.  Click the Refresh button periodically until the 

Run Status shows "Success" and the Details

  

 link is active. It could take some time for the 
status to change if you are running a large report or the system is heavily loaded.   

 
Note: You can exit at this time and return later to view your report. Open the process 
monitor from the Direct Access People Tools > Inquire > Process Requests menu path to 
return to this point. 

Continued on next page 
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Using Process Scheduler's Web Delivery Option, Continued 

  
Procedure (continued) 

 
Step Action 

7 Click the Details link.  The Process Detail Page will display. Click the View Log/Trace

  

 
link. 

 

Continued on next page 
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Using Process Scheduler's Web Delivery Option, Continued 

  
Procedure (continued) 

 
Step Action 

8 The Report Log Viewer page will open in a new window.  Access your report by 
clicking the link with the report name and number in it (In the example below, 
cgasqrpt_476108_frm.htm is the link to the report). 

 
  
Note:  You can also right mouse click and save the report (advisable if you selected the 
CSV format). 

 

Continued on next page 
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Using Process Scheduler's Web Delivery Option, Continued 

  
Procedure (continued) 

 
Step Action 

9 Your report will open and display in the web browser. 
  

 Bookmark the report page and you can view it later (within 5 days) without having 
to run the report again. 
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ASQ Status Report 

   
Introduction 
 

Unit Commanding Officers, SPOs, Assignment Officers (dxr), CGPSC(rpm), 
and MLC and HQ analysts access Screening Questionnaire data via a query to 
identify members who indicate they are not available for recall, so that 
appropriate follow-up can be made. The same query also identifies Ready 
Reservists that have not answered the questionnaire. 
 
Commands also have the ability to monitor their unit’s ASQ compliance 
through the Coast Guard Business Intelligence (CGBI) system.  
 
Click on the 'CG Analytics' tab and select "ASQ" from the Analyst Scorecard 
section. 
 
Unit commanders can then drill down to their unit and personnel to view 
individuals ASQ compliance. 

  
Procedure Start Internet Explorer, sign into Direct Access and follow these steps to 

complete this procedure. 

  
Step Action 

1 Select menu items in the following: 
Enterprise/Main Menu > Administer Workforce > Administer Workforce (GBL) > 
Report > ASQ Status Report 

2 If the Run Control ID is known (e. g. The process has been used before.), enter it in 
the space provided and click the  button. 

 
Or, click the Add a New Value

 

 link to create a new Run Control ID. Enter a Run 
Control ID and click the Add button. 

The Run Control ID can be any name to identify this report in the future.  Save the 
report requests and run them again by selecting the Run Control ID created in this 
step. 

Continued on next page 



Error Feedback, Reports and Queries 

X-2-8 CH-2 Reports & Queries 

ASQ Status Report, Continued 

  
Procedure (continued) 
Step Action 

3 The Run Control for the ASQ Status Report page will display:  

 
4 Select Unit Relationship type (ISC or PERSRU) or select Deptid to report on an 

individual department ID number. 
Relationship 

Type 
Will Report ASQ Status of all reservists assigned to units 

All 
Departments 

in all departments of the USCG.  

ISC 
 (district) 

in that district's area of responsibility. 
 

PERSRU 
(SPO) 

in that SPO's area of responsibility. 
 

Deptid to the Department ID number entered.   
 
Note: The report will not include members assigned to sub-
departments.  If this option is selected, the user will need to add 
the sub-department ID numbers by clicking the  in the 
department ID field. 

 

Continued on next page 
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ASQ Status Report, Continued 

  
Procedure (continued) 

Step Action 
5 Enter the department ID number for the district, SPO or department to report on.  If 

the Deptid unit relationship was selected in the previous step, there will be a  
available to insert additional department ID numbers to include in the report. 
 
Sample of  Department Descriptions: 

 
 
ISC (district) Department ID Numbers: 

 
Note: Use the  button to perform a lookup of valid ISC, PERSRU or department ID 
numbers. The lookup will not locate sub-department ID numbers. 

6 Click the Run button. 

 
 

Continued on next page 
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ASQ Status Report, Continued 

  
Procedure (continued) 

Step Action 
7 The Process Scheduler Request page will display. 

 
8 Select Web from the Process Type drop-down menu. 

 
Note: The Email option is obsolete. 

9 Select the file format CSV (Readable by MS Excel, text editors, other spreadsheet 
programs and database applications.)  CSV is currently the only working file format. 
Recent changes to the report included the addition of several columns of occupational 
data. The PDF and HTM file formats cannot accommodate the additional data. 

10 Click the OK button to launch the process and return to the Process Scheduler Request 
page. 

11 Click the Process Monitor link in the upper right-hand corner of the Process Scheduler 
Request page. 

 

Continued on next page 

Notice that the 
process instance 

# is added. 
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ASQ Status Report, Continued 

 
Procedure (continued) 

Step  Action 
12 The Process Monitor page will display.  Click the Refresh button periodically until the 

Run Status shows "Success" and the Details link is active. It could take some time for 
the status to change if running a large report or the system is heavily loaded.   

 
13 Click the Details link.  The Process Detail Page will display. Click the View 

Log/Trace link. 

 

Continued on next page 
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ASQ Status Report, Continued 

  
Procedure (continued) 

Step Action 
14 The Report Log Viewer page will open in a new window.  Access the report by right-

clicking the link with the report name and number in it (In the example below, 
cgasqrpt_615427.csv is the link to the report) and selecting "Save Target As...” 

 
Note:  When right mouse clicking and selecting "Save Target As" the user will be 
asked to select a location on the system to save the file to. 

15 When the download is complete click the open button: 

 
16 The report will open in MS Excel. Adjust the column widths to view all of the 

information. 
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Active Duty 6th or 10th Anniversary Query 

  
Introduction This report allows the user to query the system to show members who are 

within 90 days of their 6th or 10th year anniversary of active duty date. 

  
Before you 
begin 

Set Internet Explorer to Allow Pop-ups from the Direct Access site. 

  
Usage 

 

Per 3-C-11.2, CG Personnel Manual, COMDTINST M1000.6(series), an 
Administrative Remarks, CG-3307, entry is required for personnel within 3 
months prior to their 6 or 10 year active duty anniversary date. These 
members may reenlist before their 6th or 10th anniversary (regardless of their 
expiration of enlistment date) in order to be eligible for a Zone "A" or "B" 
Selective Reenlistment Bonus. Run this report monthly to identify members 
within the area of responsibility who need to be counseled on Selective 
Reenlistment Bonus eligibility. 

 Continued on next page 
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Active Duty 6th or 10th Anniversary Query, Continued 

 
Procedure Start Internet Explorer, sign into MyPortalDirect and follow these steps to 

complete this procedure. 
 

Step Action 
1 Select menu items in the following order: 

 
Enterprise/Main Menu > Direct Access People Tools > Query Manager > Use > 
Query Manager 
 
• The Find an Existing Query page will display, with defaults set to: Search By: 

Name, Begins With, and a third blank box to enter the name of the query.  The first 
two defaults are fine to find this report.  Use the third box to enter the query name: 
CG_SRB_REPORT 

 
• After entering the name of the query, click the yellow Search button. Hitting Enter 

will NOT return the query, but rather a message indicating the user must click the 
Search button. After clicking Search, the report will show up under Search Results.  

 
• Click Run to begin running the report. 

2 There are two blank fields waiting to be entered: 
• DEPT LEVEL 
• Department 

 

Continued on next page 
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Active Duty 6th or 10th Anniversary Query, Continued 

  
Procedure (continued) 

 
Step Action 

2 The DEPT LEVEL is a drop-down list.  It contains 6 entries: 
• Human Resource Site - Okay to choose 
• Integrated Support Command - Okay to choose 
• Own Unit Only - Should NOT be chosen 
• SWE Testing Unit - Should NOT be chosen 
• Training Quota Mgmt Center - Should NOT be chosen 
• Unit Relationship - Should NOT be chosen 
 
Note: The user may choose EITHER Human Resource Site OR Integrated Support 
Command. Click the magnifying glass beside the Department window to "lookup" 
the Department ID number. This will open the Department Lookup page.  Enter the 
desired department or click on the yellow Lookup button and pick the department 
from the list provided.  Either way, the user must click on the desired department 
before returning to the CG_SRB_REPORT - Anniversary Date Report page.   

3 Click the yellow View Results button. The query results will appear directly below 
this button. 

 

Continued on next page 
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Active Duty 6th or 10th Anniversary Query, Continued 

  
Procedure (continued) 
Step Action 

4 The query results will display. Use the Download results in: Excel Spreadsheet 
or CSV Text File
 

 links to save a copy of the query to the local system. 

Note: For best results, click on the CSV Text File link and select the Save option 
from the resulting dialog box. Then, open the file with MS Excel. 
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Accomplishment Report 

  
Introduction 
 

This section provides procedures for running an accomplishment report in 
Direct Access. This report provides a listing of a member's awards, degrees, 
ASVAB scores, foreign language skills, professional memberships, licenses 
and certifications. Reports can be run for all personnel at a department, and 
for all departments associated with a PERSRU or ISC. The member 
classification (regular active duty, drilling SELRES, IRR, etc.) can also be 
defined when requesting the report. 

  
Procedure 
 

Start Internet Explorer, sign into Direct Access and follow these steps to 
complete this procedure. 

 
Step Action 

1 Select menu items in the following order: 
Enterprise/Main Menu > Develop Workforce > Manage Competencies (GBL) > 
Report > Accomplishments 

2 If the Run Control ID is known (e. g. The user has performed this process before), 
enter it in the space provided and click the  button. 

 
Creating the Run Control ID:  If the user has not run this report before, click the 
Add a New Value link (near the bottom of the page) and create a new Run Control 
ID. The ID can be any name to identify the report (no spaces are permitted). Click the 

button. 

 

Continued on next page 
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Accomplishment Report, Continued 

  
Procedure (continued) 

Step Action 
3 Selecting the Department or Relationship criteria:  

 
Select the All Departments, ISC, SPO (PERSRU) or Deptid radio button.  
 

Relationship 
Type 

Will include rosters…  

All 
Departments 

for all departments of the USCG.  

ISC 
 (district) 

for all units associated with that district's area of responsibility. 
 

PERSRU 
(SPO) 

for all units associated with that SPO's area of responsibility. 
 

Deptid for the Department ID number entered.   
 
Note: The report will not include members assigned to sub-
departments.  If this option is selected, the user will need to add 
the sub-department ID numbers by clicking the  in the 
department ID field.  

Important:  The user must use the  icon to search for the department ID number. 
Do not enter a department ID number directly in the DeptID field. The report will 
only run when a master Department ID number is selected. If a Sub-Department ID 
number is entered, the report status will show as an error in the Process Monitor, and 
will not provide any results. 
Error Message:  Error online 393: (SQR 3722) Could not set up Cursor. 
 
Edits have been put in place in Direct Access so that only the master ID’s are listed 
when running a report. If a user needs a list of the sub-departments at their unit, they 
can do a search within the airport terminal.  

Continued on next page 
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Accomplishment Report, Continued 

  
Procedure  (continued) 

Step Action 
4 Choose the accomplishment type by clicking on the  and selecting from the list. 

 
 
 
*NVQ is not used 

Type Description 
Degree Educational accomplishment 

Honor/Awrd Awards 

Language Foreign language skill 

Licenses/Cert Licenses & Certifications 

Membership Professional memberships 

Test ASVAB test results 
 

5 Complete the accomplishment description if desired. Click the  to lookup 
description codes.  
• This field may be left blank to include all codes. 
• Use the  or  buttons to add/remove codes to report on. 
Example multiple award code entry: 

 
6 Select an employee class if desired. 

 
Select one or more employee classes for the roster or leave this field blank for all 
classes. Use the  icon to lookup available classes. 

 
Use the  or  buttons to add/remove employee classes. 

Continued on next page 

http://www.uscg.mil/hq/cg1/psc/ps/member_competencies/licenses.htm�
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Accomplishment Report, Continued 

  
Procedure (continued) 

Step Action 
7 • Click the  button and complete the Process Scheduler Request page. 

• You may leave the Server Name drop-down blank. 
• Click the Type drop down menu and select Web. 
• Click the Format drop-down menu and select PDF or CSV. 
                                                

• Click  to continue. This will return to the report setup page. Note that a Process 
Instance Number has been added just below the Run button. 

                                         
The Process Instance number is used in the Process Monitor to identify the request. 

8 Click the Process Monitor link. The report will show a run status of "Queued" as it 
processes. The user may wait for the page to update automatically or press the 
Refresh button. When the report is finished, the run status will change to "Success."  

                   
Click the Details link to view additional information if the status shows as "error".  

9 Please see the Using Process Scheduler's Web Delivery Option topic on page 3 to 
view the report.  

10 To use this report's criteria in the future, click the  button. If the user exits 
without saving, the report will still run and be delivered via email.  
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Begin Service Report 

 
Introduction 

 

This section provides the procedure to run a Begin Service Report for field 
units serviced by the SPO or for just one unit. Use the output of this report to 
determine which members need a Begin Extension of Enlistment (P198) or 
Begin Re-extension of Enlistment (P199) transaction submitted. 

  
Discussion 

 

There are two versions of this report. One report will show extensions/re-
extensions with effective (begin) dates coming up within the next 30 days 
(from the current date). The other will allow the user to select a date range to 
identify unexecuted extensions/re-extensions for any range of dates. 

  
Procedure 

 

Start Internet Explorer, sign into Direct Access and follow these steps to 
complete this procedure. 

Step Action 
1 Select menu items in the following order: 

Enterprise/Main Menu > Direct Access People Tools > Query Manager > Use > Query 
Manager 

2 A search page will appear. Enter the search criteria as described below. 
 
Search by Name, select “begins with” and enter “CG_EXT” in the third block.  Click 
the Search button.  The Search Results should include 
"CG_EXT_REX_NOT_EXEC_QRY and “CG EXT REX WITHIN 30DAYS QRY”.   

 
Click the Run
Select:  

 link for the appropriate report needed. 

• CG_EXT_REX_NOT_EXEC_QRY -- to specify the date range to search for.  
• CG EXT REX WITHIN 30DAYS QRY - to see unexecuted extensions/re-extensions 

with begin dates in the next 30 days (from the current date). 
The Query input page will open in a new window 

Continued on next page 
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Begin Service Report, Continued 

  
Procedure (continued) 

Step Action 
3 • Enter “AUSCG” in the “Enter SITID of ‘AUSCG’” block.    

• Enter the DEPTID or click on the search icon for a valid list of departments.   
• Select “Human Resource Site” for the Rel Type for all units served by the SPO 

(provided that a valid SPO department ID was entered in the Dept ID field) or select 
"Own Unit Only" to see results for only one unit.  

 
• If selecting CG_EXT_REX_NOT_EXEC_QRY, enter the Effective Dates (From 

and To). 

 
4 Click the View Results button to run the report 

 
The report provides the following information: 

Field Description 
ID Employee ID 

Name Name in Last,First,MI format 
Job Title Rating 

Contract # Number of contract (001=first extension, 002= second extension,etc.) 
Eff Date The date the extension will begin 

Type Extension (in this case submit a Begin Extension of Enlistment 
(P198) transaction on the member) 
Re-Extension (in this case submit a Begin Re-extension of 
Enlistment (P199) transaction on the member) 

DeptID Member's currently assigned department ID number 
Dept Name of unit 

 

Continued on next page 

Begin Service Report, Continued 

http://www.uscg.mil/hq/cg1/psc/ps/modify_obligation/begin_extension_of_enlistment.htm�
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Procedure (continued) 
Step Action 

5 Download the results in MS Excel format by clicking the link above the query results.  

 
6 Repeat step 3 above to run the report for additional departments. Close the report 

window when finished. It will return to the Query Manager search page.  
7 Sign out of the system or use the menu links to access another item. 
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Competency/Qualifications Report 

  
Introduction 
 

This section provides procedures for running a competency report in Direct 
Access. Use this procedure to obtain a listing of a member's qualifications. 
Reports can be run for all personnel at a department, and for all departments 
associated with a SPO or ISC. The member classification (regular active duty, 
drilling SELRES, IRR, etc.) can also be defined when requesting the report. 

  
Procedure 
 

Start Internet Explorer, sign into Direct Access and follow these steps to 
complete this procedure 

 
Step Action 

1 Select menu items in the following order: 
Enterprise/Main Menu > Develop Workforce > Manage Competencies (GBL) > 
Report > Competencies  

2 If the Run Control ID is known (e. g. The user has performed this process before), 
enter it in the space provided and click the  button. 

 
Creating the Run Control ID:  If the user has not run this report before, click the 
Add a New Value link (near the bottom of the page) and create a new Run Control 
ID. The ID can be any name to identify the report (no spaces are permitted). Click the 

button. 

 
3 Selecting the Department or Relationship criteria:  

 
Select the ISC, SPO (PERSRU) or Deptid radio button and lookup and select a 
department ID number.  

Continued on next page 
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Competency/Qualifications Report, Continued 

  
Procedure (continued) 
Step Action 

3 
cont. 

Relationship 
Type 

Will include rosters…  

ISC 
 (district) 

for all units associated with that district's area of responsibility. 
 

PERSRU/SPO for all units associated with that SPO's area of responsibility. 
Deptid for the Department ID number entered.  Use the  or  

buttons to add/remove department IDs. 
 
Note: The report will not include members assigned to sub-
departments.  If this option is selected, the user will need to add 
the sub-department ID numbers by clicking the  in the 
department ID field.  

Important:  The user must use the  icon to search for the department ID number. 
Do not enter a department ID number directly in the DeptID field. The report will 
only run when a master Department ID number is selected. If a Sub-Department ID 
number is entered, the report status will show as an error in the Process Monitor, and 
will not provide any results. 
Error Message:  Error online 393: (SQR 3722) Could not set up Cursor. 
 
Edits have been put in place in Direct Access so that only the master ID’s are listed 
when running a report. If a user needs a list of the sub-departments at their unit, they 
can do a search within the airport terminal. 

4 Enter the competency code to report on. Click the  to lookup competency codes 
(complete listing of DA competency codes). This link will open an Excel spreadsheet, 
which can be saved to the local directory. If saving the file, remember to check back 
here periodically for updates. The revision date is listed in the first cell of the 
spreadsheet. There's also a link in the file to COMDT (CG-1B1) for questions or 
changes. 

 
• This field may be left blank to include all codes. 
• Use the  or  buttons to add/remove codes to report on. 
Example showing entry of multiple competencies to report on: 

 

Continued on next page 
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Competency/Qualifications Report, Continued 

  
Procedure (continued) 

Step Action 
5 Select an employee class if desired. 

 
Select one or more employee classes for the roster or leave this field blank for all 
classes. Use the  icon to lookup available classes. 

 
Use the  or  buttons to add/remove employee classes. 
Example showing two employee classes to report on: 

 
6 Click the  button and complete the Process Scheduler Request page. 

 
• You may leave the Server Name drop-down menu blank. 
• Click the Type drop-down menu and select Web. 
• Click the Format drop-down menu and select PDF (for Adobe Acrobat (.PDF) 

format) or  CSV (for comma delimited format). 

Continued on next page 
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Competency/Qualifications Report, Continued 

  
Procedure (continued) 

Step Action 
6 

cont. 
 

• Click  to continue. This will return to the report setup page. Note that a Process 
Instance Number has been added just below the Run button. 

                                         
The Process Instance number is used in the Process Monitor to identify the request. 

7 Click the Process Monitor link. The report will show a run status of "Queued" as it 
processes. Either wait for the page to update automatically or press the Refresh 
button. When the report is finished, the run status will change to "Success." 

 
Click the Details link to view additional information if the status shows as "error". 

8 Please see the Using Process Scheduler's Web Delivery Option topic on page 3 to 
view the report. 

9 To use this report's criteria in the future, click the  button. If the user exits 
without saving, the report will still run and be delivered via email. 
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ID Family Members/Dependents by Birth Date 

  
Introduction 

 

The ID Family Members/Dependents by Birth Date query provides a listing 
of family members/dependents with a date of birth occurring before a date 
specified.  The query can be run by department ID, unit relationship, 
HRS/PERSRU relationship or ISC relationship.  Use this query to identify 
members' dependent children who are over the age of 21.  Children over the 
age of 21 cannot be listed as "BAH Eligible" unless they meet the criteria for 
student status or are incapacitated. Consult chapter 3-F of the U. S. Coast 
Guard Pay Manual for more information. 

  
Before you 
begin 

Set Internet Explorer to Allow Pop-ups from the Direct Access site. 

  
Procedure Start Internet Explorer, sign into Direct Access and follow these steps to 

complete this procedure. 
 

Step Action 
1 Select menu items in the following order: 

Enterprise/Main Menu > Direct Access PeopleTools > Query Manager > Use > 
Query Manager 

2 The Find an Existing Query page will display. Click in the blank field to the right of 
"begins with" and enter "CG_ID", then click the search button. 

 
3 Click the Run link in the search results section. 

Continued on next page 
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ID Family Members/Dependents by Birth Date, Continued 

  
Procedure (continued) 

Step Action 
4 The Query page will display in a new window. Enter the criteria and click the View 

Results button. 

 
 

Field Description 
Enter SetID 
of 'AUSCG' 

Enter AUSCG, this selects Active units. Do not leave blank and do 
not enter anything else. 

DeptID Enter the Department ID number. Use the lookup icon to search for 
the ID if necessary.  
Note:  Enter the ISC or PERSRU department ID number to show 
all units in the AOR.   

Rel Type Select the Relationship Type from the drop-down list: 
• Human Resource Site

• 

 -- Will return results for all units in the 
HRS/PERSRU's AOR. 
Integrated Support Command

• 

 -- Will return results for all units 
in the ISC's AOR. 
Own Unit Only

• 

 -- Will return results for the department ID 
number entered. 
Unit Relationship

Note:  Relationship Types are administered through the 
following menu: Home > Develop Workforce > Plan Successions 
(GBL) > Setup > Dept Relationships  

 -- If a unit relationship has been setup, will 
return results for the unit ID entered and related units. 

• If the "Own Unit Only" relationship type does not provide any 
results, use the Dept Relationships maintenance menu and setup 
the Own Unit Only relationship, this is not established in the 
system for all units. It has to be setup at least once. 

Date of 
Birth 

Enter a date. The query will return all family members/dependents 
with a birth date earlier than specified. 

 

5 The query results will display. Use the Download results in: Excel Spreadsheet 
or CSV Text File
Note: For best results, click on the 

 links to save a copy of the query to the local system. 
CSV Text File link and select the Save option 

from the resulting dialog box. Then, open the file with MS Excel. 
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Last Good Conduct Award Query 
 

  
Introduction 
 

The Good Conduct Award Query identifies personnel by departments, who 
have a Good Conduct Award (CGSD award code) which was issued within a 
specified range of dates. The department and date ranges are entered by the 
user at the time the query is run.  This query can be used to identify personnel 
who are due their second or subsequent Good Conduct Award.  Personnel 
who have not yet received their first award will not be listed.  Units should 
manually track the first Good Conduct Award due dates for these members. 

  
Procedure Start Internet Explorer, sign into Direct Access and follow these steps to 

complete this procedure. 

 
Step Action 

1 Select menu items in the following order: 
Enterprise/Main Menu > Direct Access PeopleTools > Query Manager > Use > Query 
Manager 

2 The Query search list will display. Enter all or part of the query name -- 
CG_Good_Conduct_QRY (note the use of underscores (__) in place of spaces), in the 
field between "begins with" and "User" in the Search By line, click the  button.  

 
Click on the Run GOOD CONDUCT QRY to the right of  in the search results list to 
launch the query. 

 

Continued on next page 
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Last Good Conduct Award Query, Continued 

  
Procedure 
 

Step Action 
3 Enter the query criteria. 

 
 

Field Description/Entry 
Enter 

SetID of 
‘AUSCG’ 

Enter AUSCG. 

DeptID The department ID number. Use the  to lookup the department ID if 
necessary. 

From Date The date range to begin from. Awards with a date on or before this 
date will not be listed in the query results. Dates are entered using all 
numbers in MM/DD/YYYY format. 

To Date The date range to end at. Awards with a date on or after this date will 
not listed in the query results. Dates are entered using all number in 
MM/DD/YYYY format. 

Rel Type Click the  to display available choices.  There are several options 
but only these two will return any results:  
• Human Resource Site, will include results for all units for which a 

PERSRU is responsible for. 
• Integrated Support Command, will include results for all units in 

the ISC's area of responsibility. 
 

  

Continued on next page 
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ID Family Members/Dependents by Birth Date, Continued 

  
Procedure (continued) 
Step Action 

4 Click the    View Results   button to run the query. 
5 The query results will be shown below the data entry area. 

 
6 The user may download the results in MS Excel format by clicking the link above the 

query results.  
7 Repeat steps 3 and 4 to run additional queries or use the menu to exit the application. 

  
Help Desk 
Notes 

Role -- CGSSCMD 
Owner -- Team East COMDT (CG-634) 
Production -- Release 4  
Known Issues -- The Own Unit Only option seems a better choice to get 
results for one unit, but the correct way to do this is to choose Unit 
Relationship. 
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Leave Delete Report 

  
Introduction 
 

This section provides the procedure for running the Leave Delete Report. 

 
Background 
 

A review of member leave deletions was conducted by PPC's Financial 
Account Review branch (FAR) at the request of PPC's Operations Division to 
determine if deletions to previously posted annual leave transactions were 
being submitted properly, and to identify any potential abuse.  The audit 
revealed there were personnel assigned to a SPO who had deleted leave on 
their own account, then adding the leave back into their account.  The audit 
also revealed the SPOs are not keeping sufficient leave records to verify the 
proper/improper deletion of leave.  It was also found that in a majority of 
cases where leave is charged as excess at the time of separation either 
previously reported leave is deleted or the endorsements are changed to bring 
the leave balance to zero.  Of the 3,457 deleted leave documents, 404 were on 
YN accounts.  This was a greater number of deletion/submission than any 
other rate.  This fact is notable because the YN rate is not the largest and one 
would assume because YNs are the most knowledgeable in this field, they 
would have the least number of deletions.  

  
Description 
 

The report includes the following information 

Field Description 
EMPLID Member's employee ID number 
DEPTID Department ID for the member's unit 
BEGIN DATE Start date on the original leave transaction 
END DATE End date on the original leave transaction 
DELETE DATE Date the transaction was deleted 
OPRID The user ID of the person who deleted the transaction 
OPERATOR NAME The name of the person who deleted the transaction (Last, First) 
JAG PROC DT Date the delete transaction audit record was created 

Continued on next page 
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Leave Delete Report, Continued 

 
Procedure Start Internet Explorer, sign into Direct Access and follow these steps to 

complete this procedure. 
 

Step Action 
1 From the Enterprise or Main menu, select menu items in the following order: 

Administer Workforce > Monitor Absence (GBL) > Report > Leave Delete Audit 
Report 

 
2 The Run Control ID Entry Page will open. 

• If this process has been used before, enter the initials (or other ID used to create the 
control) in the Run Control ID block and click the  button. 

• If this is the first time using this process, click the Add a New Value
1. Enter initials in the Run Control ID block. 

 link. 

2. Click the  button. 
 

3 Report Setup Page will open. 
• Select Unit Relationship type (ISC or HRS-SPO) to report on. 

 
(Note: Other values (Self, SWE, TQC & Unit) are not valid for this report) 

• Enter the Department ID number of the ISC or HRS site to report on. 
• Enter a Start Date. Leave deleted before this date will not be included in the report. 
• Enter an End Date. Leave deleted after this date will not be included in the report. 

Continued on next page 
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Leave Delete Report, Continued 

  
Procedure (continued) 

Step Action 
4 

 
Click the  button to begin processing. 

5 The process scheduler request page will open.  
• Set the Type to Web (to access the report online (See Using Process Scheduler 

Web Option for more information). 
• Set the Format to PDF (for an Adobe Acrobat file) or CSV for a file that can be 

opened in MS Excel. 

 
6 Click OK to run the report. 
7 Retrieve the report from the Report Server if using the Process Scheduler Web 

Option. (See page X-2-3). 
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PPC SPO Manual 

Part X, Error Feedback, Reports and Queries 

Chapter 3, Ad Hoc Request Procedure 

Overview 

 
Introduction This section provides the procedure for requesting ADHOC reports from PPC 

Topeka. 

 
Before You 
Begin 

Set Internet Explorer to Allow Pop-ups from the Direct-Access site. 

 
Existing 
Reports and 
Queries 

Please review the available reports and queries in Chapter 2 of this part before 
submitting a request for an ADHOC report. 

 
Discussion Additional queries may be available depending on which user roles are held. 

 To see a list of queries, select the following menu items: People Tools, 
Query Manager, Use, and Query Manager. 
  
Enter CG in the Search for box and press Search.  Review the list of queries 
available. Press the Run link for any query desired. 
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Procedure 

  
Introduction Follow this procedure to request an ADHOC report. 

 
Procedures If unable to locate a report or query in Direct Access that meets the required 

needs, or if data is needed from another system that is managed by PPC 
(JUMPS or TPAX), the user will need to submit a request for an ADHOC 
report. Follow these steps to submit a request: 
 

1. Go to the PPC Customer Care web page at 
http://www.uscg.mil/ppc/ccb/,  

2. Select the "I am a Command, SPO or ADMIN support user" option 
from the User Role for This Issue list 

3. Select "PERSONNEL ACTION" from the Category section of the 
online Trouble-Ticket form. 

4. Select the "HR DATA REQUEST" option in the Type section of the 
form.  

5. Select the "ADHOC REPORT" option in the Reason section of the 
form. 

6. Enter a complete description of the query in the "requirements for the 
ADHOC report request" section of the form.  

Example:  
  

Please provide a list of all personnel attached to the 
USCGC Example (WLB-X12), OPFAC 18-12345, from 1 May 2006 
through 30 April 2007. We need to determine eligibility 
for a Unit Commendation. Provide results in MS Excel 
format with the following columns: 
  
Name (last, first, mi) 
Rate/Rank 
Current Unit (ID and Description) 
Report date (on USCGC Example) 
Depart date (if departed USCGC Example) 
  
Point of contact: YNC Jim Smith, (757) 555-1212. 

  
The request will be forwarded to PPC (PS&R) for a direct reply. 
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